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EXECUTIVE SUMMARY 
 

 

 
This White Paper provides detailed information about how to migrate multiple user 
mailboxes from Google G Suite (Apps/Gmail) to Microsoft Office 365.  
 
It contains recommendations about preparing the Source and Target message 
platforms/servers to ensure the proper permissions are in place, which eliminates 
the reliance on individual user passwords.  
 
It also provides in-depth information about specific features that alter the default 
behavior of Transend Migrator, and identifies best practices that enhance 
migration efficiency. 
 
Step-by-step instructions detail how to configure the tool and perform the 
migration from beginning to end. 
 

 
 
 
 

Need more help? 
 
If you can’t find the information you seek, please view the Help File, which contains 
the most detailed information about every feature within the tool, including 
additional best practices.  
 
Please also contact us directly to get answers to your questions, as well as inform 
us of what’s missing in this White Paper – we’re always looking for ways to improve 
our offering, and documentation is an important piece of the puzzle. 
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Section 1:   Introduction 
 
This Technical Reference Guide details how to perform a batch migration of the following data types 
using Transend Migrator: 
 

 Email Messages/Folders  Calendar Entries 
 Address Books  Tasks/To Do Items 

 
For more detailed information about your specific application, security requirements, and additional 
migration options, please review the Help File. The Transend Migrator Help File is context sensitive. 
Selecting a help button will take you to the specific section in the Help File related to the screen you are 
in. 
 

Section 2:   User Interface Overview 
 
Transend Migrator contains an easy to use interface, designed to simplify the migration experience 
while allowing for maximum flexibility. Setting up your project to convert E-mail, Address Books, 
Calendars, and Tasks is accomplished within one user interface allowing you to quickly complete your 
migration in one run.  
 
Menu Bar 
 
The Menu Bar is where you will make your data type selections. The top level Menu is where you will 
find additional commands for saving configurations, setting various migration options, setting and 
viewing logging and reporting options,  and setting up batch migrations for multiple users.   
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User Interface 
 
The same interface is used whether you are migrating a single user mailbox or multiple user mailboxes 
at once (Batch Mode). Each screen for E-mail, Address Book, Calendar, or Task/To Do items is similar. 
Differences relate to the specific item types. The Email Configuration screen is shown below. 
 

 
 

1. The Top Level Menu is where you set Migration Options, review log 
files, configure batch migration data and enter your lciense information.  

 

6. The Copy Configuration button allows you to copy configuration 
information from the first screen into all other data type configuration 
screens. By default, Transend Migrator will fill in the information it can 
for you. Once you make changes, then this button allows you to update 
the other data type screens with those changes. Only similar or like-
fields will be updated. When you use the Copy Configuration button, 
you must re-enable the other data types for migration. 

2. The Buttons represent each data type available for migration: E-mail, 
Address Book, Calendar, and Task/To Do. You can migrate one or more 
data types at a time. Each data type needs to be configured individually 
and enabled individually.  A green checkmark will appear on the button 
when it is enabled for migration. 

7. The Target drop-down menu displays a list of all the available systems 
you can migrate into. 

3. The Source drop-down menu displays a list of all the available messaging 
systems you can migrate from. 

 

8. After the Target system is chosen, data entry text boxes will display. Fill 
out the information required for your target system. 

 

4. After the Source system is chosen, data entry text boxes will display. Fill 
out the information required for your source system. 

9. Enable the migration after you have configured both the source and 
target system by checking the Enable Migration checkbox. Once a data 
type is enabled a green checkmark will appear on that section’s button. 
Only the Enabled data types will migrate.  

5. The Folders button allows you to specifically choose or exclude 
individual email folders. By default, all folders will migrate. Therefore, 
you do not have to configure the source Folders list. This is optional. 

10. Select the Start Batch Migration button when you are ready to proceed 
with the migration.  
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Section 3:   Preparation of Source and Target Environments 
 
Ensuring that you are properly prepared for migration is essential to a successful migration experience.  
 
Time zones 
Set the migration workstation to the same time zone as the mail server.  Do not use UTC Coordinated 
time zone as this may result in incorrect dates/times for migrated items. 
 

Preparing Google Apps/Gmail for Migration 
 
When migrating to Google Apps or Gmail, you can specify either Google Single User, Google Apps 
(service account), Gmail IMAP (service account) or Gmail IMAP (single user).  Google Archive can be 
used as a source only from Gmail. Under either Single User mode, you must provide a password for that 
user. Under both Google (service account) options, you must create a service account in the Google 
Developer’s Console and Authorize the service account as the administrator of the Google Apps domain 
in Google Admin Console. Under this option, you can migrate all of your users without needing the 
password for each Google user account. 
 
Administrative Service Account: OAUTH 2.0 
 
This option implements OAuth 2.0 with the service account option. Once OAuth 1.0 is no longer 
supported, this will be the only method of doing a migration using administrator credentials. You will 
grant permission to a service account to access your Google Apps data. In most cases this will be a 
service account created by you.  
 
 

For information on how to set up a Google Service Account, view the Creating a Google Service Account 
white paper. 
 

 
Transend Migrator Service Account 
 
Transend has set up an existing service account that will be used by default; however, this opens up a 
security hole, since anybody who has Transend Migrator will be able to access your data during the 
period that access has been granted to that account.  When you run Transend Migrator, this option will 
prompt you to supply your service account email, and a pathname of the private key file. Both of these 
fields may be left blank, in which case Transend’s service account is assumed.  
 
Note: you still have to grant access to Transend’s service account (email: 
24974064516@developer.gserviceaccount.com), and as previously noted, this opens up your data to 
anybody with Transend Migrator so it is recommended to setup your own service account with 
administrative rights. 
 
 

For information on how to grant access to Transend’s Service Account, view the Granting Access to the 
Transend Service Account white paper. 
 

 
 

https://www.transend.com/wp-content/uploads/Setting-up-Google-Service-Account-1.pdf
https://www.transend.com/wp-content/uploads/Granting-Access-to-the-Transend-Service-Account-1.pdf
https://www.transend.com/wp-content/uploads/Granting-Access-to-the-Transend-Service-Account-1.pdf
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To use Google Apps API, configure Transend Migrator as shown with Google Apps (service account) 

Enabled the following custom option: 

Migration Options>Custom Options>Gmail/Google Apps>Authorization Service Account 

You can remove the Optional Service Account Email and Optional Private Key File fields since this 

authorization is now enabled in this custom option. 

 

1. Enter the Google Email Address for the 

user. 

2. Click Test Login and confirm that you are 

able to connect to Google after making 

these updates. 

3. Click File>Save Configuration 

 
 
 
Google Single User  
 
If you have selected Google Single User as your source or target system, the first time you perform a 
migration, you will be shown a browser window that will allow you to log on to Google. Google will then 
ask you for permission to allow Transend Migrator to access your data. Press the Accept button, and the 
migration will proceed. The next time you try to migrate the same Google user, no browser window will 
be needed, because the authorization key is stored in the registry on your computer. If you try to 
migrate a different user, then the same process will be repeated. 
 
 

1. Enter the Google Email Address 

for the user. 

2. Click Test Login and confirm that 

you are able to connect to 

Google after making these 

updates. 

3. Click File>Save Configuration 
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Click ACCEPT to allow Transend Migrator access to the single user data using the user’s login and 

password to Google. 

 

Google Archive 
 
Google allows its users to create an archive of various types of data, including email, calendar, and 
contacts, among other types (as of this writing, tasks are not supported). An archive consists of a zip file 
containing files in industry standard formats, such as mbox, .ics, and .vcf.   Google Archive is a source 
option not a target migration option in Transend Migrator. 
 
Transend Migrator works directly with the zip file, saving you the steps of unpacking the file and figuring 

out where to store the data, and how to tell Transend Migrator where and what the data is. With this 

option, you can select "Google Archive" as the convert-from choice and have it all done automatically. 

Using a Google Archive, versus direct access, also has the advantage of allowing Google to compress the 

data on its servers before being downloaded. In contrast, if you access email, for example, via IMAP, the 

data is not compressed during transfer, and thus the conversion will be slower. In addition, no throttling 

(deliberate slowing) is done during a zip file download. 

 

For information on how to create a Google Archive, view the Creating a Google Archive white paper. 
 

 

 

 

https://www.transend.com/wp-content/uploads/Creating-a-Google-Archive-1.pdf
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1. Once you have created and downloaded your archive .zip file, you may select "Google Archive" from 

Transend Migrator's email, calendar, or address book menus. Specify the name and location of the 

.zip file. For mail, you may select which folders to convert. For calendar and contacts, you may 

specify which calendar or address book to convert, or accept the default option. 

2. Click Browse to locate the downloaded Google Archive zip file. 

 

3. Click the Copy Configuration button and enable for Email, Address Book and Calendar.  

4. Click File>Save Configuration. 

Preparing Office 365 for Migration 
 
Transend Migrator uses Exchange Web Services (EWS) when migrating email, address books, calendars, 
and tasks to or from Office 365. 
 

Setting Full Access Permissions 
 
You can migrate user accounts without user passwords if your migration account has full access 
permission to the user accounts. You must assign full access permission and then enable the 
/AUTHEWSD <parameter> or /AUTHEWSI <parameter> custom switch options. The parameter value is 
the migration account and password authorized to access the user accounts. 

 
Impersonation 
 
The following example explains how to setup an Impersonation account in Office 365 so that you will be 
able to migrate user accounts without the need for user passwords. This is a basic example and you may 
need to adjust your system to allow Impersonation. 
 

1. Sign into the Exchange Admin Center for Office 365 using an Admin account. 
2. Click Permissions from the menu on the left hand side of the screen. 
3. Click on Admin roles from the top menu. 
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4. Click on the Add a new Admin Role Group icon. 
5. Give the role group a new name, such as “Transend Migrator”. 
6. Add and Assign the “ApplicationImpersonation” role to the group. 
7. Add the member who will receive this permission. 
8. Save this new role group. 

 
After enabling and assigning Impersonation to a user account in the Office 365 Exchange Admin Center, 
add the Impersonation account email address and password into the /AUTHEWSI <account|password> 
custom switch option in Transend Migrator.  
 

1. Choose Migration Options from the menu. 
2. Select Custom Options. 
3. Expand the Exchange Web Services section. 
4. Choose the EWS Impersonation switch (/AUTHEWSI) if your source is Office 365 or EWS 

Impersonation switch (/AUTHEWS2) if your target is Office 365. 
5. Enter the Impersonation account and password: (syntax: admin account/password). 

 

 
 

6. Click the Enabled checkbox to enable the custom option. 
7. Press the OK button to return back to the Transend Migrator desktop. 
8. Now you may enter the target server and account information, but passwords are no 

longer required. 
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Delegate Access 
 
You may also use Delegate Access to migrate user accounts with the need for passwords. Once 
Delegation or Full Access Permission is assigned to your Migration Account, enable the /AUTHEWSD 
<parameter> custom option switch in Transend Migrator and enter the migration admin account logon 
and password for the parameter value. 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

Choose EWS Delegation Access /AUTHEWSD if your source is Office 365 or choose EWS Delegation 
/AUTHEWSD2 if your target is Office 365. 
 
Note 
The following PowerShell command is a basic example on how this can be accomplished; however, your 
environment may need additional options. 
 
Example 

get-mailbox -ResultSize Unlimited | foreach {Add-MailboxPermission -Identity $_.Identity -User 
admin@mycompany.onmicrosoft.com -AccessRights FullAccess -InheritanceType All} 
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Section 4:   Batch Migration Setup 
 
Setting up a batch process is nearly as easy as setting up a migration for a single user account. All batch 
data is stored in a Transend Migrator Data (TMD) file which contains all of the settings and options you 
have configured within the user interface. Select File | Save Configuration under the main menu to save 
all the current configurations to the default.tmd or custom TMD file. 
 
Before configuring and processing a batch migration, we recommend you first test the conversion of one 
user mailbox to become familiar with how Transend Migrator operates.  
 

Assigning Batch Variables 
 
Once you have configured and tested a single user mailbox migration, you are now ready to turn your 
project into a batch migration by assigning variables to values that can change (usually the mail 
database or source user name, password, and target accounts).  You assign these variables to values by 
populating the Batch Mode Data table. 
 
The Batch Mode Data table is located at Batch Migration | Batch Migration Setup from the main menu. 
To perform a batch migration, the Batch Mode Data table needs to be populated with all the users’ 
account information required for the migration. You provide this information by entering it into each 
row and column cell, or by importing a comma delimited text file you have already created. The 
information required will vary depending on the email system you use. 
 

Notice in the example, each column is 
associated with a variable, and those 
variables are $var1 through $var8. The user 
data is populated into the table, and one row 
represents one user’s data, and those are 
the values for the variables. Once all the data 
is entered, select the OK button to return 
back to the main interface and the data type 
you are working on (E-Mail, Address Book, 
Calendar or Task/To Do). Next, substitute the 
user account information with the variables 
found on each column header. 

 
Note 
The checkboxes are in read-only mode; however, you may right-click on the checkbox and select the 
appropriate option. You may also move your cursor to the checkbox field and press the space bar to set 
or clear the checkbox. 
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Loading User Mailbox Account Data 
 
Load From File: The Load From File button allows you to load a text file, which is a comma separated 
value file, of the values you want to fill into the variables columns. In your migration, collect user data 
into a database or spreadsheet and then organize the user data by columns and rows. Extract the data 
into multiple comma separated value files (CSV) and import those CSV files by batches. 
 
The following CSV file uses the semi-colon as a delimiter instead of the comma. This is useful to use 
when a value has a comma, and when the comma cannot be used. 
 

 
 
Transend also supports uploading from an Excel Spreadsheet saved as a MS-DOS CSV file. 
 

 
 
Load From Directory: The Load Column From Directory button allows you to load file or directory 
information into the column of your choice. This feature is helpful when you have migrations based 
upon files or directories rather than from direct connections, such as with Exchange/Outlook, Lotus 
Notes, and Novell GroupWise. 
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Compare the following two screenshots to see how the variables can be used. The first screen shot 
shows the configuration of a single-user email migration. The second screenshot shows how variables 
can be inserted into the configuration screen to turn a single-user migration into a batch migration.  
 

Single User Migration Batch Migration (with Variables) 

  
 
 
The objective is to look for user data that will remain constant, and user data that needs to change. 
 
Review your data as it is entered in the Batch Mode Data table, and then substitute what needs to 
change with the appropriate variable (e.g. $var1, $var2, etc.). 
 

Validate Batch Setup 
 
Use this feature to test your batch settings before beginning your batch migration. This feature will test 
the logon for each section you specify, and for each user listed in the Batch Mode Data table. 
 
Batch Migration Setup Test 
 
 

1. Select the source and target types you want to test the 
logon for. 

2. Press the Start Test button. 
3. Review your results. 
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Batch Migration Setup Report 
 
Review the Batch Migration Setup Report results. If there are any connection failures, press the View 
Log button to review the log file generated during the test. 
 

1. Press the View Report button to view test results. The 
report is created in XML, and viewable with Microsoft 
Excel. It will list each data type tested (email, address 
book, calendar, and task), and will report the success or 
failure of the source and target connection test. 

2. Press the View Log button to view the master log file 
generated during the test. The log file is the master log 
file, and it will show the results of your validation test. 
Review this log file if you have a connection test failure, 
and look at the end of the log file for your latest test. 
Failures are recorded in red. 

 

Migrated Checkboxes 
 
The first column in each row has a checkbox that tracks which accounts have been successfully migrated 
thus far. If the box is checked it means that user has successfully migrated. You can then restart your 
migration and only migrate users who do not have a checkmark in the Migrated column. 
  
After a migration is run, all users who were successfully migrated will have their Migrated checkbox 
checked. This checkbox information is stored along with the other migration data within the TMD file. 
Therefore, it is very important to save the TMD file before and after a migration. When you exit 
Transend Migrator after a migration you will receive a warning if you have updated checkboxes and are 
attempting to exit without saving. 
  
When you run the same migration again by pressing the Start Batch Migration button, Transend 
Migrator will give you the option of converting just the unchecked entries, or to convert them all. 

 
Right click to see the options: View log for record 1, Change Migrated State, Set All Rows to Migrated or 

Set All Rows to Not Migrated 
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Enable Migration 
 
When you are finished inserting the different variables in the appropriate locations, enable the 
migration by checking the Enable Migration Checkbox. Notice, the green checkmark will appear on the 
appropriate tab after fully configuring and enabling a migration section. 
 

 
 
 

Copy Configuration 
 
If your migration will include Address Books, Calendars, or Task/To Do items, and those data types will 
use the same account information as Email, select the Copy Configuration button to copy your changes 
to the other data type sections. 
 

 
 
Helpful Hint 
 
It is possible you will want to migrate data that is in a different format as the email system data you are 
migrating. For example, you could be migrating email from an IMAP system, but your Address Books are 
LDIF files and your Calendar items are VCS files. Transend Migrator is very flexible and configurable to 
your unique environment. However, in this situation you would NOT want to use the Copy Configuration 
button. 
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Section 5:   Folders 
 
By default, all available folders will migrate during email conversion. You can change this behavior by 
selecting the specific folders you want to migrate or selecting specific folders you want to exclude.  
 

 
 
Folder Convert List 
 
The Folder Convert List is blank by default. When the list is blank this means that all folders available in 
the source account will migrate. You may want to press the Load from E-Mail Source button to review 
the available folders so that you can manually choose which folders to migrate. Remove a checkmark if 
you do not want a specific folder to migrate. 
 
You may also want to load the list of folders into the Folder Convert List so that you can create a list of 
folders you do not want to migrate. For example, maybe you do not want to migrate the Junk Mail 
folder for one account, or for all accounts. Right click on the folder you do not want to migrate, add it to 
the Folder Exclude List, and then press the Clear Data button to remove all entries from the Folder 
Convert List. When the Folder Convert List is empty, this tells Transend Migrator to convert all folders 
except what is listed in the Folder Exclude List. 
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Folder Exclude List 
 
You may want to exclude certain folders from being migrated. Select a specific folder you wish to 
exclude, right-click, and then choose the To Exclude List option to copy the folder name to the Exclude 
List. This is commonly used in Batch Mode so that a specific folder will be excluded for all accounts. This 
is helpful for when you want to migrate all available folders except for a select list. After adding folders 
to the Folder Exclude List, remember to clear the list of folders in the Folder Convert List. 

 

 
 
1. Enter the names of the folders you wish to exclude. 
2. Optionally, if you have a text file containing folder names to exclude you may load that list by 

pressing the Load From File button. 
3. Right Click in this window for other options on these entries. These Unicode features are helpful 

when migrating non-English character sets. 
OR 

4. Click Migration Options>Email Convert List 
5. Click Load from Source 
6. Right click and select the folder and select Add to Folder Exclude List 
7. Use the wildcard * to include subfolders 
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Folder Mapping 
 
Folder Mapping allows you to migrate a folder with a certain name into another folder with a different 
name. In many email systems, folders have similar functions yet they have different names. For 
example, new messages received into Lotus Notes are placed inside the Notes Inbox folder. In Microsoft 
Exchange, new messages received are placed inside the Inbox folder. If you want the Notes Inbox items 
migrated from the Lotus Notes Inbox into the Microsoft Exchange Inbox then create a Folder Map.  
  
You may also map to a new folder on the target email system. Enter the new name into the New Folder 
Name field and messages specified within the Original Folder Name field will migrate into that folder. 
 

Enter the folder names by putting your 
cursor into the text box and then begin 
typing.  
 
Press the Tab key to get to the next 
textbox on the list.  
 
Press Shift-Tab to go to the previous 
textbox on the list. 

 
 
 
Suggestion 
An easy way to load the Original Folder Name is to load the folder list on the Folder Convert List tab, 
right click on the folder to be mapped, and then choose the Add to Folder Map menu option. This 
feature will copy the folder name into the Original Folder Name textbox on the Folder Mapping tab.  
 
Because the folder names must be exact, adding the Original Folder Name from the Folder Convert List 
will ensure it is entered in correctly. 
 
Load From File 

You may also create a comma separated value (CSV) file containing a list of Original Folder Names and 
the New Folder Name. Save this file as a text file. Load the text file into the Folder Mapping table and 
the entries will fill into the Original Folder Name and New Folder Name fields. 
 
Example Map File 
 

The CSV file is a text file with these two values. 
Each line contains the exact name of the Original 
and Target folder name separated by a comma. 

 
Note 
If you do not want to map any folders but want to place all folders into a Group Folder, use the Group 
Folder switch found in Migration Options | Custom Options. The switch is /GN <value> where value is 
the name of the group folder.  
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Section 6:   Address Translation 
 
Transend Migrator supports address translation through the Address Translation Table. You can access 
the Translation Table under Batch Migration | Batch Migration Setup |Address Translation from the 
main menu. 
 
The Translation Table allows you to create Internet Style addresses based upon the criteria you provide. 
The Translation Table is helpful to use if you are changing the email address of your users and if you 
want Transend Migrator to make those changes during the migration. It is also helpful to use when 
migrating distribution lists and calendar attendees. 
  
Transend Migrator expects to find a match within the Address Translation Table. Changes will only be 
made to matches found. 
 
The Address Translation Table is divided into two sections. The first section is the Old Address format, 
and the second section is the New Address format you want it to be. The Old Address section of the 
Address Translation Table must be in the exact format the source application stores it. 
 
Translation Table Example 
 
Enter the Address Translation Table data into the fields provided on the Address Translation tab. You 
may also import your csv text file containing address translation data into the Address Translation 
interface. 
 

 
 
For more detail about Address Translation refer to the Transend Migrator help file. 
 
 



Google G Suite (Apps/Gmail) → Office 365 
Technical Reference Guide 

 

Page 18 of 34 
 

Section 7:   Migrating Messages/Folders (Step-by-step) 
 
The following is a step-by-step guide of how to migrate E-Mail from Google Apps/Gmail to Office 365: 
 

1. Select the Email button to configure the email choices. 
2. Select Google Apps (service account) from the From drop down box on the Source Pane (left side 

of the screen). 
3. Enter the Google Email Address and Service Account info (if necessary). 
4. Select the Folders button to choose which folders to migrate. All folders will migrate by default if 

no folders are displayed in Email Convert List. 
5. Select Office 365 from the From drop down box on the Target Pane (right side of the screen). 
6. Enter the Server Name, User Email and Password (if necessary). 
7. Insert the different batch variables in the appropriate source and target locations (if necessary) 

to migrate multiple accounts in batch mode. 
8. Place a checkmark in the Enable Migration Checkbox to enable Email for migration.  
9. Optionally, confgure and enable the other migration choices (Address Book, Calendar, and Task) 

if they are to be included with this migration. 
10. Select the Start Batch Migration button to complete the migration. The Migration Monitor will 

start and display the real-time migration progress.  
11. Once complete, select the OK button to go back to the main screen. 

 

All options implement the OAuth 2.0 protocol. The only difference is that Transend Migrator 
will connect to Google IMAP servers instead of using servers that support the Google http API. 
We have found that usually the IMAP service is faster, however it may be subject to throttling, 
i.e. a deliberate slow down by Google. 
 

 

Office 365 Considerations 

 Remove mailbox data/attachment quotas during the user migration, or only migrate what the target 
email system can support. 
 

 You might want to migrate historical data into the Office 365 Archive database or into Microsoft 
Outlook PST files to prevent against server overload. 
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Section 8:   Migrating Address Books (Step-by-step) 
 
The following is a step-by-step guide of how to migrate Address Books from Google Apps/Gmail to Office 
365: 

 
1. Select the Address Book Button to configure the Address Book choices. 
2. Select Google Apps (service account) from the From drop down box on the Source pane (left side 

of the screen). 
3. Enter the Google Email Address and Service Account info (if necessary). 
4. Select Office 365 from the To drop down box in the Target pane (right side of the screen). 
5. Enter the Server Name, User Email Address and Password (if necessary). 
6. Insert the different batch variables in the appropriate source and target locations (if necessary) 

to migrate multiple accounts in batch mode. 
7. Place a checkmark in the Enable Migration Checkbox to enable Address Book for migration.. 
8. Optionally, confgure and enable the other migration choices (Email, Calendar, and Task) if they 

are to be included with this migration. 
9. Select the Start Batch Migration button to complete the migration. The Migration Monitor will 

start and display the real-time migration progress.  
10. Once complete, select the OK button to go back to the main screen. 

 

Section 9:   Migrating Calendar Entries (Step-by-step) 
 
The following is a step-by-step guide of how to migrate Calendar Entries from Google Apps/Gmail to 
Office 365: 
 

1. Select the Calendar button to configure the calendar choices. 
2. Select Google Apps (service account) from the From drop down box on the Source pane (left side 

of the screen). 
3. Enter the Google Email Address and Service Account info (if necessary). 
4. Select Office 365 from the To drop down box in the Target pane (right side of the screen). 
5. Enter the Server Name, User Email Address and Password (if necessary). 
6. Insert the different batch variables in the appropriate source and target locations (if necessary) 

to migrate multiple accounts in batch mode. 
7. Place a checkmark in the Enable Migration Checkbox to enable Address Book for migration.  
8. Optionally, confgure and enable the other migration choices (Email, Calendar, and Task) if they 

are to be included with this migration. 
9. Select the Start Batch Migration button to complete the migration. The Migration Monitor will 

start and display the real-time migration progress.  
10. Once complete, select the OK button to go back to the main screen. 

 
 
 
 
 



Google G Suite (Apps/Gmail) → Office 365 
Technical Reference Guide 

 

Page 20 of 34 
 

Section 10:   Migrating Tasks & To-do Items (Step-by-Step) 
 
The following is a step-by-step guide of how to migrate Task/To Do Items from Google Apps/Gmail to 
Office 365: 
 

1. Select the Task/To Do button to configure the task choices. 
2. Select Google Apps (service account) from the From drop down box on the Source pane (left side 

of the screen). 
3. Enter the Google Email Address and Service Account info (if necessary). 
4. Select Office 365 from the To drop down box in the Target pane (right side of the screen). 
5. Enter the Server Name, User Email Address and Password (if necessary). 
6. Insert the different batch variables in the appropriate source and target locations (if necessary) 

to migrate multiple accounts in batch mode. 
7. Place a checkmark in the Enable Migration Checkbox to enable Address Book for migration.  
8. Optionally, confgure and enable the other migration choices (Email, Calendar, and Task) if they 

are to be included with this migration. 
9. Select the Start Batch Migration button to complete the migration. The Migration Monitor will 

start and display the real-time migration progress.  
10. Once complete, select the OK button to go back to the main screen. 
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Section 11:   Custom Options 
 
Custom Options are additional settings that allow you to alter the default behavior of Transend 
Migrator. All Custom Options are detailed in the Help File.  
 
Select Migration Options | Custom Options from the main menu in order to configure available options.  
 

 
 

Search Information 

If you want to enable an option but do not know where to find it, enter a keyword inside the search text 
box to search for the option. Transend Migrator will search for that keyword inside the entire Custom 
Options section and display the results. 
 
Select the Next button to review all the sections where your keyword was found. You may also search by 
a specific option switch (e.g. /D140). Sometimes an option can be found in two or more locations. 
Review the correct location for the option and then enable it in the source or target section related to 
your specific project. 
 
Review enabled Options by selecting the View Enabled Options button on the Custom Options screen or 
by selecting Enabled Migration Options from the View menu. These choices will display all enabled 
options by category. 
 

Commonly Used Custom Options 
 

Custom Option Switch Description 

Installation 

 Proxy Server /PROXY 
For license key verification. Internet access is required. If your network uses a 
proxy server then you will need to use this switch. 

General 

 Date Range /UADATE Migrates email, calendars, and task items within a given date range. 

 Message Date Range /MSGDATE Migrates only messages within a given date range. 

 Calendar Date Range /CALDATE Migrates only calendars within a given date range. 

Max Message Size /MAXMSGSIZE 
Set the Max Message Size as 25000 KB’s or 25 MB which is the Office 365 
limit. If the sum of the attachments causes the entire message to exceed 



Google G Suite (Apps/Gmail) → Office 365 
Technical Reference Guide 

 

Page 22 of 34 
 

25000 KB’s or 25 MB, the attachments will be removed and replaced with a 
text stub. 

 Max Attachment Size /MAXATTACHSIZE 
Any attachment with a size greater than this value will be removed and 
replaced with a text stub. 

 Detach Attachments /DETACH 

Use this switch when the Max Attachment Size switch is enabled. When the 
attachment exceeds the maximum attachment size, the attachment will be 
placed into the directory specified by the /DETACH switch.  Create a directory 
on the migration workstation called c:\detach and apply a variable so each 
user has a directory for attachments, the parameter is specified as 
c:\detach\$Var1 

Recurring Calendar Entries /D127 
Recurring calendar entries will appear in the target as true recurring events, 
instead of separate individual events.   

Recurring Calendar 
entries - Expand 

/D179 
Forces calendar entries to expand where supported. 

Migrate Unique Messages /DEDUP 
Migrate unique messages and to record the MD5 hash value of the messages 
into a new or existing file. 

Deduping File Writes /D165 
Write the MD5 hash values immediately to the dedup file after each message 
instead of writing to memory. This will affect the speed of the migration, but 
allows better recovery from a crash. 

Deduping Criteria /D56 
Only used when the /DEDUP switch is enabled, and it overrides the default 
behavior. Choose which fields to run the MD5 Hash algorithm against. 

Exchange/Outlook Specific 

 Max PST /MAXPST 
Used to limit the size of the output PST file, and start creating another PST file 
when the first file has reached its limit, which is 1.5GB by default. 

Public Folder Access /EWSPUB Enable this switch to read from or write to Public Folders. 

Exchange Web Services (Office 365) 

EWS Impersonation 
/AUTHSI - Source 
/AUTHSI2 - Target 

Enable Impersonation to migrate as admin without user passwords as 
described in Preparing Environment – Office 365, add the admin email 
address/password in this custom option. 

EWS Delegation  
/AUTHEWSD - Source 
/AUTHEWSD2 - Target 

Enable Delegation to migrate as admin without user passwords as described 
in Preparing Environment – Office 365, add the admin email 
address/password in this custom option. 

Allow Calendar Invitees /D211 
Forces attendees to be included in calendar events.  Test in your 
environment, may cause unwanted email invites. 

Google Apps / Gmail 

Authorization – Service 
Account 

/XOAUTHSA 

Enable to migrate bulk users in batch mode without having to use each user 
password. For Google Service Account email,  calendar, contacts, or tasks 
migrations, specify the service account email and path to P12 key in the form: 
service account email address|path to P12 key file 

Attachment Rename - 
Google 

/D189 
Append “.dat” to file attachments containing “bad” extensions, such as .exe, 
to prevent Google from rejecting the message. 

Logging / Reporting 

Debug Logging /DEBUG 
Adds additional logging to the log file, which is helpful when troubleshooting. 
It attempts to log every single step of the migration which causes the log file 
to get quite large. 

Log Subjects  Adds the Subject line information to the tmlog 

Log Time Stamps  Add the timestamp to the tmlog 

Migration Report Level /XMLREPORTLEVEL 
Use this switch and value to determine the level of detail recorded into the 
XML report. 

Throttling Options   

Maximum Stall Seconds /MAXSTALL 
Sets the number of seconds the batch mode will allow a migration process to 
be idle for before failing the migration.  Default is 180 seconds. 

Reconnect /D197 
Allows Transend Migrator to reconnect to the server when the tcp/ip 
connection fails (the default is 3). 

Timeout /TO 
Increase the Timeout when connecting to the IMAP server (default is 25 
seconds). 
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Message Deduping 
 
Transend Migrator has the ability to prevent duplicate message items from migrating. This feature is 
helpful in the event you want to restart a migration, or run a delta. It is also helpful when you restore 
many email archives from a particular person, and you want to output only the unique messages. 
 
When deduping enabled, Transend Migrator performs a calculation called an MD5 hash on each 
message item to see if it is unique. It writes that the results of the MD5 hash into memory. At the end of 
your migration, the MD5 information is taken from memory and written to file. 
 
The calculation is performed on the following metadata items to see if they are unique or different: 
 

 Message Body 

 Subject 

 Date 

 Sender 

 Recipient List 
 
These default metadata items can be changed, and you can also add additional requirements such as: 
 

 Folder 

 Attachment Header 

 Attachment Data 

 Unique ID 
 
Enable Deduping: 
 

1. Select Migration Options from the menu. 
2. Select Custom Options from the sub menu. 
3. Expand the General section to see the section choices. 
4. Enable the section titled, “Migrate Unique Messages”.  
5. Press OK to complete this custom option. 

 
When no parameter is entered, Transend Migrator will first write the MD5 hash value of each message 
into memory, and then write that information into a file called md5.dat, and this file will be created 
inside the same directory as the master log file (tmlog.html). 
 
Suggested Deduping Options 
 
Sometimes, a migration will fail and end abnormally. When this happens, the MD5 information in 
memory does not get written to disk. Therefore, when this happens you will have some duplicate email 
items if you decide to migrate all message folders over again. Therefore, you can force Transend 
Migrator to write the MD5 information to disk immediately instead of waiting until the migration is 
complete.  
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Deduping in Batch Mode using a Variable 
 
In batch mode, it is common practice to create an md5 hash file for each account migrated. In batch 
mode, variables are defined, such as $var1, for the name of the dedup file. Often, a variable is a user 
name so consider using the user name as the variable. It is easier to keep track of the file if it is related 
to the user name, and you will only have to use one variable. 
 

1. Turn on deduping by enabling the Custom 
Option Setting called, “Migrate Unique 
Items. 
 

2. Add a path and filename to the 
Parameter. Use an existing file or create a 
new file. Use the same file if you plan on 
deduping between migrations. 

 
 
 
 

3. Enable the /D165 switch, which is titled, 
Deduping File Writes. This switch forces 
Transend Migrator to write the MD5 hash 
value to disk immediately rather than 
after the migration is over. 

 
 
 
 
 

4. Optionally, enable the /D56 switch and 
then modify the default value, which is 
BSDNR. Add at the F value if you want to 
include the message folder as part of your 
deduping criteria. This might not be a 
good idea if migrating from Lotus Notes 
and you are migrating views and folders. 
This might be a good idea if you are 
migrating from another program and you 
want duplicate items in different folders. 
Perhaps, the folder is important.  
  

5. Deduping Criteria  - Use these parameters 
in the Deduping Criteria switch to choose 
which fields to run the MD5 Hash 
algorithm against 

 

Note 
You cannot share the dedup file with another process. Therefore, create a unique dedup file for each account migrated. 

F = Folder B = Message Body  S = Subject 

D = Date  R= Recipient List  N = Sender 

H = Attachment Header (name and length) 

A = Attachment Data   U – Unique ID  
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Section 12:   Command Line Processing 
 
An alternate way of starting a batch migration is through the command line or with a batch file. Once all 
Email, or Address Book, or Calendar, or Tasks sections have been set you normally begin the migration 
by pressing the Start Single Migration or the Start Batch Migration button. You may also start a 
migration through a command line after saving your configuration using the File | Save Configuration 
As… menu choice. 
 

1. Setup a migration project for one user or for a batch of accounts. 
2. Load the user list if you are migrating in batch mode. 
3. Save your configuration by selecting File | Save Configuration As… from the main Transend 

Migrator screen. Name the configuration file and keep it short. Once have saved your settings 
into a configuration file you can then run a batch migration from the command line. Review the 
Command Line Syntax & Example section for the command line detail. 

 
Command Line Syntax & Example 
 

  
Syntax 
  

  
TM12.EXE /CMDL /F <path and filename> 
  

  
Example 
  

  
TM12.EXE /CMDL /F C:\ProgramData\Transend\Project.tmd 
  

  

  
TM12.EXE 
  

  
This is the Transend Migrator executable. If you run this command all by itself then Transend 
Migrator will start in regular mode. 
  

  
/CMDL 
  

  
This switch tells Transend Migrator to run in command line mode. It expects the /F <filename> 
switch. 
  

  
/F <filename> 
  

  
The /F switch tells Transend Migrator to perform a migration based upon the settings saved inside 
the TMD filename specified. 
  

 
Additional Options 

  
/CONCURRENT <n> 
  

  
Allows # of concurrent migrations to be set through the command line rather than using the 
Migration Monitor interface. 
  

 
Note 
The command line must be executed from the Transend Migrator installation directory. It will be easier 
to create a batch file using Notepad rather than manually running it from the command line. Below is an 
example of a simple batch file: 
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1. Start Transend Migrator and configure the settings for one or more accounts. 
2. Save your configuration by selecting File | Save Configuration from the main Transend Migrator 

screen. For this example, save your configuration file into C:\Migrate\project.tmd 
3. Create a batch file and use the Batch File Example as a guide. 

 
Batch File Example 
 

 
 
Run the Batch File 
 
Double-click on the batch file using Windows Explorer. Once the batch file starts it will load the 
Migration Monitor and begin migration. When the migration completes the Migration Monitor will exit. 
 
Provide accounts in CSV file 
 
Normally, in a command line migration all your settings and account information is saved in the 
Transend Migrator configuration file (TMD); however, you may save the account information inside a 
CSV file and reference that CSV file. This is useful when you will be automating the user list extraction 
and do not have the ability to save the user information in the TMD file. The CSV file will contain the 
values for the variables you define in the TMD file. Use the /batchdata <file> switch in addition to your 
other command line switch choices. Any values declared in the TMD file will be replaced, and the values 
in the CSV file will be used. 
 
Batch File Example with CSV file containing user information 
 

Example 
TM12.EXE /CMDL 1 /F C:\ProgramData\Transend\Project.tmd /batchdata 
C:\Migrate\Userlist.csv 

 

Section 13:   Migration Monitor 
 
The Migration Monitor displays the real-time status of all user mailboxes as they are migrated. The 
Migration Monitor is a multi-threaded process, which means that multiple accounts can be migrated at 
the same time if the email systems support concurrent migrations, and if your license permits. 
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Section 14:   Concurrent Migrations 
 
Transend Migrator has the ability to migrate more than one account at a time, and this is called 
Concurrent Migrations. During a batch process, Transend Migrator will migrate each account in entry 
order, which is defined in the Batch Mode Data table. It starts at the top and works through the list until 
the list is complete. If your license allows, you may migrate more than one account at a time. This allows 
you to complete your project more quickly. 
 
Adjust the number of concurrent migrations when you begin a migration and the Migration Monitor 
appears. Transend Migrator will default to 1 concurrent migration. Press the up or down arrow to adjust 
the number of concurrent migrations. 
 

Performance 
 
Increase the number of concurrent migrations to attain the best possible speed your system will allow. 
Each computer system is different, and each email system is different. Migrating data on a local machine 
gives you one rate of speed, while migrating across a local area network will give you a different rate of 
speed. The number of email messages and attachments will also affect your migration rate, as will the 
size of those messages and attachments. 
 
The best way to determine how fast you can perform a migration is by setting up a few test accounts 
and giving each account 1 Gigabyte of normal email data. Migrate one account at a time and review the 
rate of speed. Then, migrate the same test accounts and increase the number of concurrent migrations 
to 2, and so on. Evaluate the rate of speed and the combined rate of speed. Lower the number of 
concurrent migrations when you see a decrease in migration rate 
 

Adding Migration Workstations 
 
At some point, you will reach the maximum capability of your migration workstation, and you may want 
to add more workstations to decrease the amount of time it takes to migrate your accounts. Review 
how long it takes to migrate 1 GB of data on a single workstation, determine the number of concurrent 
migrations your workstation will allow, and then calculate how much faster your project will complete 
by adding workstations. 
 

Calculating Migration Time 
 
Below are examples of an easy way to calculate how long it will take to complete a migration. Create a 
simple spreadsheet that lists the total number of gigabytes to migrate, the quantity of workstations you 
will use, and then the rate of speed your system will migrate. Then, enter a simple formula to calculate 
how long your migration will complete with one workstation. In these screenshot examples, your 
formula would be: ((Gigabytes/Rate)/PC’s). 
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In Microsoft Excel, your formula would look similar to: =(E14/E16)/E15 

Spreadsheet Example 1 

 
 
In the spreadsheet example above, it will take 4.86 days to migrate 350 gigabytes of data at the rate of 3 
gigabytes per hour. Therefore, you may want to add more machines to complete your project in a 
shorter amount of time.  

 
Spreadsheet Example 2 

 
 
If you are using a simple formula, add more workstations to your spreadsheet to determine how much 
faster your project will complete. In Spreadsheet Example 2, the same migration will complete in 23 
hours if 5 workstations are used at the same time. Be careful when adding computers to your project, 
and verify your source/target servers and network can handle the workload. In you are migrating into 
Microsoft Exchange, we recommend you turn off Transaction Logging so that your Exchange Server will 
not become overloaded and use up too much disk space. Turn Transaction Logging back on when your 
migration project is complete. 
 

Section 15:   Schedule Migration 
 
You may schedule a migration to begin at a later time by setting the start time on the Migration 
Schedule screen. Start later in the evening when you can receive optimal performance, bandwidth, and 
no interruption. If there are other processes that must begin while the migration is running then you 
may also pause the migration, and continue after the processes are complete.  
  
You must configure your migration before you can schedule it. Pre-configure the E-Mail, Address Book, 
Calendar, and Tasks as they need to be set. Import your list of users if performing a batch migration, and 
then save this configuration by selecting File | Save Configuration from the Transend Migrator main 
menu.  
 
Caution 
Once the schedule has been set it will become effective and begin only after pressing one of the Start 
Migration Buttons. Migration will not happen if you close Transend Migrator.  
  
You do not have to set all options in the Migration Schedule. Only the values with an enabled checkbox 
will take effect after pressing the Start Migration Button. 
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Section 16:   Reporting / Logging 
 

Reporting 
 
Migration reports in XML format will be created after each successful run, and can be viewed with 
Microsoft Excel. XML reports can be found inside the default subfolder or in a folder containing the 
name of the custom configuration, and can easily access by selecting View | Migration Reports from the 
main menu. Each time a migration is run a new Migration Report will be created, and it will be assigned 
an incremental number beginning with the number 1. 
 

 
 
The default detail contained within the XML Report contains the following information: 
 

•    User ID 
 

•    Status 
 

•    Database / User 
 

•    Time Started 
 

•    Time Ended 
 

•    Elapsed Time 
 

•    Folder Count 
 

•    Email Count 
 

•    Address Count 
 

•    Calendar Count 
 

•    Task Count 
 

•    Attachment Count 
 

•    Skipped Entries 
 

•    Data Rate (megabytes per hour) 
 

 

Use the following switch and value to increase or decrease the level of detail in the XML Report: 
 

Switch Value Description 

  
/NOXMLREPORT 
  

  

  
Use this switch to disable XML reporting. No XML report will be produced when 
this switch is used. 
  

  
/XMLREPORTLEVEL 
  

  
<n> 
  

  
Use this switch and value to determine the level of detail recorded into the XML 
report. The default value is 1. Increase the value to 2 if you want to record Folder 
Names and Entry Counts for those folders. 
  

  
Note 
Transend Migrator reports the number of attachments converted with each message; however please 
be aware that this number may include graphic images embedded within HTML documents. Therefore, 
the number of actual attachments visible in your email client, such as Word or Excel files, may be 
different than reported. 
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Logging 
 
Transend Migrator will create a master log file named tmlog.html inside the default system directory. 
This log file contains detailed information about the migration session. User specific log files will be 
called Tmlog-#.html. The number # will correspond with the specific job number for that user as found 
in the Migration Monitor. This file contains detailed information about a specific user. Since the log files 
are HTML they are viewable by using your Internet browser. If you want text based log files then use the 
/LTEXT switch option located inside the Log File section in Custom Options. 
 
You can find the log files inside one of the following system directories: 
 

 
Windows XP 
  

  
C:\Documents and Settings\All Users\Application Data\Transend 
  

Windows Vista 
Windows 7, 8 
Windows 2008 R2 
Windows 2012 R2 
  

  
C:\ProgramData\Transend 

 
Each time you migrate an account, Transend Migrator will create a user specific log file inside a 
subdirectory from one of the two system folders listed in the above table. This subdirectory will be 
called default, which is the same name as the default configuration TMD file containing all of the 
settings and options used in the user interface. If you create custom configuration files the subdirectory 
containing user log files will be given the custom configuration’s name rather than default. 
  
The following switches are available to change the way Transend Migrator records information inside 
the user specific log files. 
 

Switch Description 

  
/LAP 
  

  
This switch tells Transend Migrator to append to the existing log file instead of creating a new one on 
each run. 

 /LL  Use this to create a Summarylog.txt file. 

 /LNO  Use this switch to disable logging. Creating a log is enabled by default. 

 /LSUB  If enabled, each message converted will have its subject added to the log file. 

 /LTEXT  Use this switch to create text log files instead of HTML log files. 

 /LTS  Adds a timestamp value to each line in the log file. 
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Section 17:   Troubleshooting 
 
General Logon Errors 
There are four possible error messages you may receive when attempting to log on to your email 
system. 
 

1. Invalid user name or ID: This error generally appears only for IMAP, Outlook, and GroupWise. 
Check that you have entered the correct user name, including case and spelling. 

2. Invalid password: As above, generally this will occur only with IMAP, Outlook or GroupWise. 
Check the spelling, punctuation, and case. 

3. Invalid database or directory: This error can occur for systems where it is necessary to identify a 
directory where email files may be found. This would include Netscape, Eudora, cc:Mail 
archives, EML, and Web. It can also occur for systems where you have to identify a specific 
database file, such as a Lotus Notes .nsf file. For Notes, the file must exist in a readable 
directory. For the other systems mentioned, assuming that the directory itself exists, the 
program is checking for the presence of specific files. For example, the Netscape directory must 
have at least one .snm or .msf file. The Eudora directory must have a .mbx file, and the Pegasus 
directory must have a .pmm file. 

4. Unable to connect with mail system: This is a generic error that can indicate a variety of 
problems. Close Transend Migrator and verify the connection with your email client. Use those 
same settings when migrating email data with Transend Migrator. 

 
Usually more information is available about a logon problem in the log file. If the error message in the 
log file is not helpful, please send a copy to our technical support for further analysis. 
 
Antivirus and Spam Filters 
If you have viruses in your email then your antivirus or spam filter might intercept those viruses during 
migration. Therefore, it is best to clean your email before or after performing a migration. If the 
message is intercepted during migration it could interfere with a successful migration. 
  
If you have antivirus and spam prevention software running on your source or target server, and even 
the workstation performing the migration, you will slow down the amount of time it takes to migrate 
your data. To improve performance and to decrease the amount of time it takes to migrate your data 
turn off antivirus or spam filtering software. Any software designed to intercept email traffic will impede 
performance. 
 
Application Violations 
These errors can be difficult to troubleshoot but are mostly related to corrupted email messages, or files 
that are not email messages but you tried to convert them. If the latter is the case then remove the 
offending file. 

1. If an application violation (AV) happens then make note of the folder the problem happened in. 
2. Enable the /LSUB switch option for logging. The /LSUB switch option will log each message 

subject converted (or attempted) into the log file. 
3. Attempt an isolated conversion of that specific folder. When the AV happens close Transend 

Migrator. 
4. Open the Log File with Notepad or alternate text editor. 
5. Make note of the last message converted. This will tell you where to look for the problem.  
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6. Open the source message account and search for the message subject causing the AV. 
7. Move that message into a TEMP or SAVE message folder. 
8. Optionally, move the next message into the same TEMP or SAVE folder. Quite often, it was not 

the last message converted that caused the AV. It could be the next one in line. Therefore, this is 
why you need to move the next one into the TEMP or SAVE message folder. 

9. Begin another migration, but this time skip the TEMP or SAVE message folder. When the 
migration is successful you can continue on. You will have successfully identified the corrupted 
or problem messages.  

 
Microsoft Outlook 
Microsoft Outlook must be the default email system for Windows when migrating Outlook email data. 
At least one profile must be created so that Outlook will set itself up for your email environment. Once 
this is done then no other profiles are needed if using the special syntax to access accounts directly.  
 
You do not need a profile to migrate multiple Exchange accounts. Profiles are not required. But, your 
Windows account must have permissions to access the account you are accessing. Contact your 
Network Administrator to gain access to other people’s email accounts. If you are performing migrations 
for selected Exchange users then you must be granted RECEIVE-AS permissions on the mailbox to be 
migrated.  
 
When you are using the Transend Migrator graphical User Interface you can migrate other people’s 
email accounts as long as you have created a profile for that user, and have the login ID and password 
for that user. This is not the recommended method. The recommended method is to be granted access 
permissions so that a password is not needed and so that a profile is not needed. 
 
If you are migrating multiple users and/or will be using the Batch Mode Processor then give your 
Windows account (the account or group doing the migration) the RECEIVE-AS permissions on the 
Mailbox Database for your Exchange Server.  
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Section 18:   Technical Support 
 
Technical support is available to help you understand how to use Transend Migrator with your migration 
project. Please review the Help File and online resources before contacting technical support. 
 
You are encouraged to submit questions through email. This will allow us time to properly research your 
situation and make appropriate recommendations. 
 
Note: Transend’s normal business hours are M-F, 9am – 5pm (Pacific). If you will be performing a 
migration during non-business hours, and anticipate a need for support during non-business hours, 
please contact us at least 7 days in advance so we can schedule a support engineer to be available, if 
possible. 
 
Sending Log Files to Transend Technical Support 
 
It is important to include a copy of your log files when submitting a support request. You may send the 
log files individually, or send the log files using the Email Log Files menu feature from the Transend 
Migrator interface using the following procedures: 
 

 
 
Select Help>Email Log Files from the menu list. Transend Migrator will attempt to open your default 
email program and then create a new message similar to the example, below. 
 

 
 
Notice 
The path to the log file package (a zip file containing your log files, report, and settings file) will be 
inserted into the body of the email message. In the example, the log file path and filename is at 
C:\Users\john.hieb\Documents\Transend_Logfiles.zip. Your path will be similar. Using your email 
program, insert the log file package. Use the path and filename listed in your email message.  
 
Before contacting technical support, we recommend that you are using the current patches or service 
packs for your hardware, your operating system and software. Also, download the latest version of 
Transend Migrator from www.transend.com. Review the What’s New section of the Transend web site 
to review the latest release information. 
 
Email:   tech.support@transend.com. 
Phone: (650) 324-5370  

http://www.transend.com/
http://www.transend.com/whats_new.asp
mailto:tech.support@transend.com?subject=Transend%20Migrator%20Technical%20Support%20Request
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Section 19:   Tech Notes 
 
Migrating Meeting Attendees into the Office 365 (Exchange Web Services) Calendar 
-------------------------------------------------------------------------------- 
 
A "meeting" is defined as a calendar event which has one or more attendees (invitees). When importing 
meetings into Exchange via EWS, the "organizer" of the event will always be the user for whom you are 
importing the calendar.  It is not possible to set the organizer to be anybody else.  This is a flaw in EWS 
that makes it impossible for Transend Migrator to create meetings exactly as if they were originally 
created in your source system.  However, there are some work-arounds that should prove acceptable. 
 
By default, Transend Migrator will not attempt to create attendees unless the organizer name (or 
organizer email) matches the Exchange user name (of the account that you are importing entries into).  
In most cases, depending on your source system, this will not match.  To make them match, you will 
need to create a Translation Table (described in the online help).  To find out what value to use as the 
source organizer name, it is helpful to do a small test calendar migration, with the debug option turned 
on (/DEBUG).  In the log file, for each event imported, you will see a line that looks something like this: 
 
debug: Organizer=Joe Snuffy <jsnuffy@source.com>, gEWSUser=jsnuffy@target.com 
 
Therefore, in the Translation Table, use either "Joe Snuffy" or jsnuffy@source.com as the Old Address, 
and "jsnuffy@target.com" as the New Address.  Once you know the format of the source organizer, you 
should be able to fill out the entire table without running any further tests. 
 
One problem with this workaround is that for users who are attendees of events, they will not see in 
their calendars who the other attendees are.  The event will be a normal event, not a meeting.  A 
possible way to deal with this issue is the switch /D207 (Allow Calendar Invitees).  If you enable this, 
then the following logic applies:  If the organizer matches, then the event is imported, however a 
special feature of EWS is activated, that will cause new invitations to be sent out to all meeting 
attendees.  If the organizer does not match, then the event is skipped.  The effect of this is that event 
attendees will not have their calendar entries migrated, but are depending on the organizer's calendar 
being migrated, thus generating new invitations in Exchange.  Once they respond, the event will appear 
in their calendar.  This method still requires that a Translation Table be set up for organizers, as well as 
an entry for attendees. It also requires that all users be set up in Exchange before any calendar 
migrations take place. 
 
A second workaround is the switch /D211 (Allow Calendar Invitees).  This simply causes Transend 
Migrator to skip the organizer match logic.  All meetings will have all attendees set.  However, this may 
cause the side effect of Exchange issuing new invitations when they are not wanted.  Please experiment 
with this feature before using on a system-wide migration. 
 
As an aside, note that if you can import calendars via MAPI (e.g. "Exchange/Outlook/PST") Transend 
Migrator has more flexibility in setting the organizer, and the above work-arounds are not needed.  
(However MAPI is not recommended for Office 365 for various other reasons). 
 

mailto:jsnuffy@source.com

